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Seamless and secure, online proctoring.



Step 1: Sign in to Examity

Step 2: Start Exam

Step 3: Systems Check

Step 4: Install Extension and Grant Permissions
Step 5: Authentication

Step 6: Review Instructions

Step 7: User Agreement

Step 8: Screen Launch

Step 9: Begin Exam/Examity Sidebar

Step 10: End Proctoring Session

Step 11: Survey (Optional)
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examity

Welcome to Examity

Examity® is the global leader in online proctoring.

. S User!

Our end-to-end solution includes authentication, ername
live monitoring, recording, and auditing.
Test takers enjoy a seamless experience Password

Si n I n tO Exa |t anytime, anywhere with lots of flexibility.

g I I I y O Forgot your password?
Need Help?
B3 Live Chat
¥ Support Phone Numbers LOGIN
I support@examity.com
REGISTER
Examity © Privacy Policy

The test-taker will need to sign in to Examity, if they have not already done so, using
the link provided in the welcome email: https://on.examity.com/V5/x/217



https://on.examity.com/V5/x/217
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Welcome to Examity

Here, you'll find your list of available exams. You can start or schedule exams, and make changes if needed.

*Pearson - IT - New_7th sp Vv

*Pearson - IT - New_7th sp — Instructor: Examity
Automated

ACCUPLACER Al - Examity review

Start Exam

Exam Window May 1, 2022 12:03 PM to Jul 28,
2022 6:59 PM

@ Exam Duration 9 hours

View Exam Rules

Once logged in, the test-taker will see their exam card on their dashboard.

The automated exam workflow does not require the test-taker to schedule their exam.
The test-taker can click Start Exam and start their exam session immediately.
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System Check

We're running a quick check to make sure your system meets the requirements to test with Examity.

& @

Webcam Microphone Operating System

System Check
i @

Browser Internet Speed

® @ Chat with an Expert

The test-taker will be prompted to complete the systems check and then press Next.
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Install the Examity
Extension

Install the Examity Extension

Good luck on your exam! We have a few quick steps to follow on the coming screens, so please take the time to complete each one.

In order to start your exam, you'll need to install the Examity Extension, grant us a few permissions, and verify your identity.

Add Extension

Chrome Extension Help

Click the button to begin.

Next, the test-taker will need to install the Examity extension by selecting Add Extension.
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& Examity Proctoring - Chrome Web Store - Google Chrome = m} X

@ chrome.google.com/webstore/detail/examity-proctoring/geapelpefnpekodnnlkcaadniodligebj

&~ chrome web store €& nghorbel@examity.com v

Home > Extensions > Examity Proctoring

Examity Proctoring
Offered by: examity.com

* 56 | Productivity | & 10,000+ users

Install the Examity
Extension

Overview Privacy practices Reviews Support Related

Add to Chrome

@ examity”

A pop-up window will appear. The test-taker will need to click on Add to Chrome.
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Install the Examity
Extension

Add Extension

& Examity Proctoring - Chrome Web Store - Google Chrome

# chrome.google.com/webstore/detail/examity-proctoring/geapelpefnpekodnnlikcaadniodligebj

&~ chrome web store

Home > Extensions > Examity Proctol

Examity Proctor

Offered by: examity.com

* v 56 | Productiy

Overview

g examity

Then, the test-taker can click Add Extension to complete the extension setup process.

Ej Add "Examity Proctoring"?

It can:

Read and change all your data on all websites
Display notifications

Read and modify data you copy and paste
Capture content of your screen

Change your settings that control websites' access to features such
as cookies, JavaScript, plugins, geolocation, microphone, camersa, etc.

Privacy practices Reviews Support

v

Q nghorbel@examity.com v

Related

Checking...

Once added, the test-taker will continue to the authentication process.
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Grant Permissions

Allow webcam and
microphone access

X | o Rm e

: Examity Proctoring wants to

& Use your microphone

©collegeBoara ACCUPLACER

Grant Permissions

@ Use your camera

We're about to ask for a few system permissions. The
You must grant both permissions to continue.

Exam Permissions Granted Q

Grant Extension Permissions

The test-taker will now be prompted to grant permission to access their webcam and
microphone. They will click “Allow” when prompted.
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©cCollegeBoard ACCUPLACER Exams History Profile System Check Logout

Grant Permissions

We're about to ask for a few system permissions. These are necessary 10 gulde you through the process and keep your exam safe and secure. If permissions are lost at any point, you will be prompted to grant them again
You must grant both permissions to continue.

Exam Permissions Granted o

Grant Permissions

Extension Permissions Granted (&

Click continue

Once permissions have been granted, the test-taker will click “continue” to proceed through
the authentication process.
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Face Verification

If prompted, click "Allow" to tum on your camera, show your face clearty, and click “Take Photo" to capture the image. You can retake the photo if it isn't clear. Once
you're happy with it, click "Use Photo and Continue" to go to the next step.

@ Integrated Camera (5986:2113) v

Authentication

@ Retake Photo

Face

Verification

The first part of the authentication process is the face verification. The test-taker will need to
take a photo — and retake if necessary — and then click Use Photo and Continue.

- @ Chatwith an Expert
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ID Verification )

Place your ID clearly in the frame and then click "Take Photo" to capture the image. You can retake the photo if it isn't clear. Once you're happy with it, click "Use Photo
and Continue" to go to the next step.

@ Integrated Camera (5986:2113 v

(. NEW YORK STATE =

DRIVER LICENSE
ID:OOOQ(_)_Q?PQ_CLASS DM

Authentication

SAMPLE,SALLY
1010 ANYPLACE ST
YOURCITY NY 12121
DOB: 07-18-83

SEX:F EYES: BL HT: 5-09
E:NONE

ID Verification

R: NONE
ISSUED: 07-18-05 EXPIRES: 07-18-13 @ Retake Photo

-

Use Photo And Continue
© Chat with an Expert

The second part of the authentication is the ID verification. The test-taker will need to take a
live picture of their ID and then select Use Photo and Continue.
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Your Challenge Question

Answer the question below using the response you gave when creating your account. You'll have three chances to answer correctly. Use our Live Chat feature if you

need help.

What is your mother’s maiden name?

Authentication o

Challenge

Question |
Copyright © 2021 Examity@ All rights reserved. Privacy Policy
Version: 2b6d17b
® Chat with an Expert

The final step of the authentication process is the challenge questions section. The test-taker
will be asked one of the three challenge questions, enter in the answer, and then click Next.
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Prepare for your Exam

It's important to make sure your space is prepared before the proctor session starts. Please pay attention to any special instructions you may have been given here.

o Review the exam rules and guidelines o Review Special Instructions

« Clear your desk and the surrounding area
« Stay connected to a power source

« No phones or headphones

« No dual monitors

« No leaving your seat

« You must be alone in the room

Review
« No Talking
.
I nst r u Ctl 0 ns « You must stay in view of the webcam for the duration of the test

« Your webcam, speakers, and microphone must remain on throughout the test

I'm Ready

Copyright © 2021 Exam\ty"’:‘ All rights reserved. Privacy Policy

Version: 2b6d17b
@ Chatwith an Expert

The test-taker will be able to review a list of the Examity standard rules, along with any
additional and special instructions if applicable.
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User Agreement

User Agreement

Take a moment to review these important items.

1. You understand that by using any of the features of the Examity web site and services, you act at your own risk, and you represent and warrant that (a) you are the enrolled student who is authorized to take the applicable exam
and (b) the identification you have provided is completely accurate and you fully understand that any falsification will be a violation of these terms of use and will be reported to the appropriate university or test sanctioning body.

2. You agree that you will be held accountable for any and all infractions associated with identity misrepresentation and agree to participate in the disciplinary process supported by the university or test sanctioning body should any

such party make any request of you

3. You also certify that you are not accepting or utilizing any external help to complete the exam, and are the applicable exam taker who is responsible for any violation of exam rules. You understand and acknowledge that the
applicable university or test sanctioning body will supply all exam rules, and the company will have no responsibility with respect thereto. You agree to participate in the disciplinary process supported by the university or test
sanctioning body should any such party make such request of you in connection with any violation of exam rules.

4. You also acknowledge that your webcam and computer screen may be monitored and viewed, recorded and audited to ensure the integrity of the exams, unless otherwise specified by your university or test sanctioning body. You
agree that no one other than you will appear on your webcam or computer screen. You understand and acknowledge any captured data, along with your test answers, will be stored, retrieved, analyzed and shared with the
university or test sanctioning body, in our discretion, to ensure the integrity of the exams.

| Agree And I'm Ready To Begin The Exa

| do not agree

Copyright © 2021 Examity® Al rights reserved. Privacy Policy

Version: 2b6d17b
@ Chat with an Expert

The test-taker will also need to review the User agreements and then click | Agree And I’'m Ready To
Begin The Exam. If the test-taker chooses I do not agree, then they will NOT be able to take the exam.
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Sharing Your Screen

You're ready to connect with Examity! Click launch and share your screen to begin

A new window will open for this step.

‘ LAUNCH \

Click LAUNCH Select the SCREEN
below to share

Examity Proctoring is sharing your screen. Stop sharing Hide @ Chatwith an Expert
Cop, . v

ol - y

Screen Launch

Now, the test-taker will be prompted to launch the screen share by clicking Launch.
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Sharing Your Screen

You're ready to connect with Examity! Click launch and share your screen to begin

A new window will open for this s

Screen Launch

Copyright © 2021 Examity@’ All rights reserved. Privacy Policy

Version: 2b6d17b
© Chat with an Expert

Then, they will need to select their entire screen and click Share.
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Learning Your Sidebar X

@ : :

Navigation Completed Exam Getting Help

Home
Messages

Help Inserting your password

Begin Exam/
Examity Sidebar

Its possible you were not on the correct page, try
Collapse/Reveal

navigating to the exam login or password page
and try the button below.

Docker Left/right

INSERT PASSWORD @
Scrollable Content

R~ SR S .t SN 1 & 8

The proctoring tools contain valuable instructions and provide means of support during your

proctoring session. Please take some time to review before you begin.

NEXT

The test-taker is now brought to the exam page. They will see a sidebar appear to the right of the
screen, followed by a Learning Your Sidebar pop-up. The test-taker will need to click through the
prompts showcasing how to utilize this feature for the duration of the exam.
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Begin Exam/
Examity Sidebar

Learning Your Sidebar X

! : @

Navigation Completed Exam Getting Help

If you need help

There are detailed answers of many
commonly asked queStions' You will also Is a portion of your exam being covered by this
be able to reach out to our support team sidebar?

via chat. No problem! Just use the docking arrows in the top
right to snap this sidebar to either side of your
screen. If you would like to reduce the sidebar then
you can use the collapse icon to collapse or expand

the sidebar.

Are vou havina connection issues or are voul

If you wish to see the tutorial screens again, there is a link in the Help tab to begin the slideshow.

The test-taker will need to click through all steps of the sidebar information pop-up
and then press Continue To Exam.
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Proctoring Instructions Proctoring Instructions
What now? What now?
Once you have finished taking your exam and Once you have finished taking your exam and
you are sure you have submitted all required you are sure you have submitted all required
documents you can end your proctoring documents you can end your proctoring
session by clicking the End Proctoring session by clicking the End Proctoring
Session Button. & ]

End PI’OCT.OFIng | End Proctoring Session?
Session

Are you finished with your Exam?

Powered by Examity, Inc Exam ID 1755025

Once the test-taker completes the exam, they will need to officially end the session
with Examity by clicking End Proctoring Session, then choose End [the] Session.
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@ examity’

©CollegeBoard ACCUPLACER

Thank you for using Examity. We'd like to take a moment to ask you a few questions about your experience
through a short survey. We value your opinion and appreciate your feedback

Course Name: Sample Course Exam Name: Sample Exam
1. How smooth was your proctoring experience?
Rough 1 2 3 4 5 6 7 8 9 Very Smooth

2. What is the greatest way for us to improve your proctoring experience?

Survey

Wouldn't change a thing Better trained proctors Make more user friendly Faster connection
.
(O ptl 0 n a I ) 3. How likely are you to suggest Examity to a student who needs proctoring?
Never 1 2 3 4 5 6 7 8 9 Very Likely

Examity®

The exam screen automatically closes after the session ends and the test-taker will now
see a survey. This survey is optional and provides Examity with feedback on the exam experience.




